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FPGA Advantage Tutorial

This tutorial uses a simple HDL text design which implements a simple Fibonacci count 
sequence which repeatedly sums the previous two numbers: 0, 1, 2, 3, 5, 8, 13, 21, 34, 55, 89 to 
144.
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Invoking FPGA Advantage
You can invoke FPGA Advantage on a Windows workstation by double-clicking the shortcut 
which was created by the install program on your desktop. Alternatively, you can choose the 
corresponding shortcut from the FPGA Advantage cascade of the Programs menu. 

You can invoke FPGA Advantage on a UNIX or Linux workstation by using a script which was 
created by the install program in the following installation subdirectory:

<install_dir>/Fpgadv/bin

Configuration Shortcut

FPGA Advantage with LeonardoSpectrum FPGAdv with LS

FPGA Advantage with Precision Synthesis FPGAdv with PS

FPGA Advantage with LeonardoSpectrum and Precision 
Synthesis

FPGAdv with LS & PS

FPGA Advantage with Precision Physical Synthesis FPGAdv with PP

FPGA Advantage Personal with LeonardoSpectrum FPGAdv Personal with LS

FPGA Advantage Personal with Precision Synthesis FPGAdv Personal with PS

FPGA Advantage Personal with LeonardoSpectrum and 
Precision Synthesis

FPGAdv Personal with LS 
& PS

FPGA Advantage Personal Simulation with 
LeonardoSpectrum and Precision Synthesis

FPGAdv Personal 
Simulation with LS & PS

Configuration Scripts

FPGA Advantage with LeonardoSpectrum fa_with_ls

FPGA Advantage with Precision Synthesis fa_with_ps

FPGA Advantage with LeonardoSpectrum and Precision Synthesis fa_with_ls
fa_with_ps

FPGA Advantage with Precision Physical Synthesis fa_with_pp

FPGA Advantage with ModelSim LE fa_with_le
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1. Invoke FPGA Advantage using the shortcut (on Windows) or invoke script (on UNIX or 
Linux) listed in the tables on the previous page. If this is the first time you invoke FPGA 
Advantage, the HDS Setup Assistant wizard is started.

2. Choose to cancel the wizard. HDS starts with the default examples project, VHDL as the 
default language and all the available flows and tools. 

You can invoke the wizard at any time by choosing HDS Setup Assistant from the Help menu 
in the Design Manager window.
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The Design Manager
The design manager displays the default SCRATCH_LIB library. The SCRATCH_LIB library is 
created in a default location defined in the examples.hdp project. On Windows, this is beneath 
the FPGA Advantage installation tree; on UNIX it is in your home directory.

Note
Note that an object tip containing information about the object under the cursor is 
displayed when you move the cursor over each object in the window.
You can display help about the design manager (including a hyperlink to the section in 
the HDL Designer Series User Manual) by clicking on the  icon.

The procedures in this tutorial use the SCRATCH_LIB library although you can use any other 
empty writable library.
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Set the Default Language
1. Choose Main from the Options menu to display the Main Settings dialog box. Select 

Verilog 95 as the default language for all new graphical and text views. Click the Apply 
button to confirm your language choice and then click the OK button to close the dialog 
box.

Note
The FPGA Advantage tutorial can be completed using either the Verilog or VHDL 
languages. Verilog has been used for the examples shown in this manual.
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Import the Fibonacci Design 
This tutorial uses a Fibonacci sequencer design example which can be imported as either VHDL 
or Verilog code. 

1. Choose File> Add> Existing Design.

2. Specify the method to add your design by selecting the Copy Specified Files option.

3. In the Folders pane, browse to the Fibonacci sequencer source code in the examples sub-
directory of your FPGA Advantage installation. For example, if FPGA Advantage has 
been installed in the directory C:\FPGAdv81LSPS, the path to locate the tutorial source 
files would be:

C:\FPGAdv81LSPS\Hds\examples\tutorial_ref\Import\Sequencer

4. From the Show files of type list box select Verilog Files.
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Click the OK button to display the Target Libraries page of the Add Existing Design 
wizard. The Target Libraries page shows the SCRATCH_LIB library as the default target 
library.

5. Click the Next button to display the Target Directories page showing where the 
imported files will appear below the root HDL mapping:

6. Select Create graphical representations of source code and click the Finish button.
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By choosing to create visual representations of your source code you thereby create 
graphical views that allow only non-logical edits. These views are tightly coupled to 
their source code and can be used for understanding and documenting your textual 
designs.

The HDL Log Window reports that the HDL import has been completed, three files 
have been imported to one library and 2 block diagrams, 1 state machine and 2 flow 
charts have been created.

Browse the Fibonacci Design
1. Select the SCRATCH_LIB library in the Design Unit’s pane of the Design Manager. 

Click the right mouse button and choose Expand All from the popup menu. 
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The design units for the Fibonacci design should now be displayed in the Design Unit’s 
pane while the visualization views should be displayed in the Files’ pane. The following 
picture shows the imported verilog design:

Each Verilog module or VHDL entity in the source HDL code is partitioned into a 
separate design unit which also includes the corresponding VHDL architectures if you 
are using VHDL. Notice that a  icon is displayed adjacent to the fibgen_tb design unit 
in the Design Units pane indicating that this test bench component is the top level design 
unit.
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Use ModelSim to Debug the Design
1. Select the component design unit icon  for fibgen_tb in the design manager. 

2. Click the ModelSim Flow button in the design manager toolbar.

FPGA Advantage attempts to run the ModelSim flow but HDL compilation fails due to 
deliberate errors in the design example source code.

The compilation status is displayed in the Log Window:

There is one error message (shown above) if you are using Verilog or five errors if you 
are using VHDL:

** Error: /user/frodo/hds_scratch/scratch_lib/hdl/Seq_Generator.vhd(87): Illegal target for signal 
assignment.

** Error: /user/frodo/hds_scratch/scratch_lib/hdl/Seq_Generator.vhd(87): Unknown identifier 'clear'.

** Error: /user/frodo/hds_scratch/scratch_lib/hdl/Seq_Generator.vhd(92): Illegal target for signal 
assignment.

** Error: /user/frodo/hds_scratch/scratch_lib/hdl/Seq_Generator.vhd(92): Unknown identifier 'clear'.

** Error: /user/frodo/hds_scratch/scratch_lib/hdl/Seq_Generator.vhd(107): VHDL Compiler exiting
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These errors are caused by an inconsistent signal declaration between the body of the 
HDL text description and its interface. You can cross-reference from the error message 
in the log window to the incorrect declaration in the source HDL by using the Cross 
reference to graphics button or by double-clicking on the message. 

3. Double-click on the error message in the log window. 

The DesignPad editor is invoked and the first line of HDL code that corresponds to an 
error message is highlighted.

Notice that the code includes two deliberate errors. If you are using Verilog, these are on 
lines 193 and 199:

193 clear = 1 ; // Deliberate error, signal is declared as clr
199 clear = 0 ; // Deliberate error, signal is declared as clr

If you are using VHDL, the errors are on lines 87 and 92:

87 clear <= ‘1’ ; // Deliberate error, signal is declared as clr
92 clear <= ‘0’ ; // Deliberate error, signal is declared as clr

The following picture shows the Verilog code:



FPGA Advantage Tutorial, Release 8.216

FPGA Advantage Tutorial
Create a Graphical Test Bench

October 28, 2008

4. Correct the errors by replacing the word clear with clr and delete all of the comment text 
after the semi-colon.

5. Click the Save button on the DesignPad toolbar to save the edits to the file.

6. Close the text editor by choosing Close Window from the DesignPad Window menu or 
by using the keyboard shortcut Ctrl + F4.

Create a Graphical Test Bench
Now that you have corrected the errors in the source code, you could use the HDL text view of 
fibgen_tb to simulate your design. However, for this tutorial you will create a graphical test 
bench which will be used to control and monitor the simulation.

1. Use the New button in the design manager window and select Block Diagram from the 
Graphical View cascade of the dropdown menu to create a new untitled block diagram.

Notice the five toolbars at the top of the diagram. The toolbar buttons provide quick 
access to many of the most frequently used editing and formatting commands.
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2. Click the Add Component button on the block diagram toolbar to display the 
Component Browser showing the SCRATCH_LIB library:

3. Select the fibgen component in the Component Browser, hold down the left mouse 
button and drag the component onto the block diagram. 

4. Repeat this procedure for the fibgen_tester component. The diagram should look similar 
to the picture shown below: 

5. Close the Component Browser.

6. Select the fibgen component instance and use the right mouse button to choose Add 
Signal Stubs from the popup menu. 
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The Add Signal Stubs dialog box is displayed prompting you to choose the type of 
ports that require signal stubs:

Note
The dialog box includes an additional Buffer option if you are using VHDL.

7. Click OK to accept the default settings and notice that two signals, clock and reset plus 
a bus named fibout are added to the ports on the fibgen instance.

8. Repeat this procedure for the fibgen_tester component. 

You are warned that the nets clock and reset already exist on the diagram and (if you are 
using Verilog) that their port and net declarations are different. These warning messages 
can be ignored. 

9. Click OK to acknowledge the warning messages. 

10. Notice that clock and reset signals plus a bus named monitor are added to the ports on 
the fibgen_tester instance. 

11. Select and delete the bus fibout. 

12. Select the connector on the monitor bus and drag it to connect on the fibout port of the 
fibgen instance.
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The block diagram should look similar to the picture shown below:

Note
It is not necessary to explicitly connect the clock and reset signals between each port on 
the fibgen and fibgen_tester components because these are implicitly connected by name.

Save the Test Bench 
1. Use the Save button to save the test bench. 

2. The Save As Design Unit View dialog box is displayed which allows you to save a 
design unit into any currently mapped library. The SCRATCH_LIB library is selected by 
default.

3. Select the existing design unit name fibgen_tb (which contains the original HDL text 
view of the test bench) and use the name struct1:

4. Click OK to save the block diagram as an alternative graphical view of the test bench.
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Set the Default View
Notice that the struct1 block diagram and a graphical symbol view are added to the 
fibgen_tb design unit shown in the design explorer.

1. Select the struct1 view below fibgen_tb in the design explorer, right click and choose 
Set Default View from the popup menu. 

This sets the graphical test bench view struct1 as the default view. An  icon next to 
struct1 indicates that it is now the default view.

For example, the following picture shows the Verilog version of the design after you 
have set the default view:

This graphical test bench will be used to control and monitor the simulation as described 
in the next section.
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Simulate Your Design
1. Select the fibgen_tb component and use the ModelSim Flow button to run the 

ModelSim flow.

The Start ModelSim dialog box is displayed:

2. Ensure that the Enable Communication with HDS option is set and click the OK 
button to confirm the dialog box.

The flow automatically generates HDL for the graphical test bench and compiles HDL 
for the hierarchy below the selected design unit.
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Note
Messages showing the progress of HDL generation and compilation are displayed in the 
HDS Log Window. You can cross-reference from the log window to the source graphics 
or HDL if any generation or compilation errors are detected.

If generation and compilation are completed successfully, the ModelSim simulator is 
invoked and the compiled design is loaded.

The following example shows the ModelSim window when a Verilog version of the 
tutorial design has been successfully loaded: 

Note
A number of warning messages are displayed in the ModelSim window when a Verilog 
version of the design is loaded. For example:
Module 'fibgen' does not have a `timescale directive in effect, but previous modules do.
These messages are issued because there is a `timescale directive in the HDL generated 
from the graphical test bench but there are no similar directives in the other HDL text 
views. These messages can be ignored for this tutorial.
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Add Probes to the Test Bench
1. Make the fibgen_tb block diagram active.

Notice that an additional simulation toolbar is displayed at the bottom of the block 
diagram when the simulator is invoked. This toolbar provides commands that can be 
used to control the simulation of the design from the graphical view.

2. Use Shift + Left Mouse Button to select the clock and reset signals and the monitor bus 
of the fibgen component.

3. Click the Add Probe button in the simulation toolbar to add probes on the diagram 
which show the current value of each signal.

4. Select the probe on the monitor signal and use the right mouse button to choose Probe 
Properties from the popup menu. The Probe Properties dialog box is displayed.

5. Choose Unsigned from the dropdown list for the Display Radix and confirm the dialog 
box.

The block diagram should look similar to the following picture:
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Note
Note that you can drag the probes to improve clarity on the diagram. The corresponding 
signal or bus is shown by an anchor line (which can be optionally displayed or hidden by 
setting an option in the Probe Properties dialog box).

Add a Breakpoint
1. Use the  icons to expand the hierarchy of the fibgen_tb design in the sim structure tab 

of the ModelSim workspace window. Select the FSM view under the U_O instance if 
you are using Verilog (or the fsm view under the i0 instance if you are using VHDL).

2. Display the ModelSim source window (by double clicking on the FSM control design 
unit in the sim structure tab of the ModelSim workspace or choose Source from the 
View cascade of the Simulate menu in the fibgen_tb test bench block diagram).

3. Navigate to line 193 if you are using Verilog (or line 87 if you are using VHDL) and set 
a breakpoint for the clr = 1 (or clr <= ‘1’) assignment by clicking once beside the line 
number. A red dot is added after the line number indicating that a breakpoint has been 
set.
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Add Signals to the Wave Window
1. Make the fibgen_tb block diagram active and ensure that the monitor bus and the signals 

clock and reset are selected. 

2. Click the Add Wave button to automatically open the ModelSim Wave window with the 
selected signals displayed. 

3. Select the fibgen_tb/monitor bus in the Wave window and use the right mouse button to 
choose Unsigned from the Radix cascade of the popup menu.

Run the Simulator
1. Arrange the test bench block diagram, source and wave windows so that they are all 

visible.

2. In the fibgen_tb block diagram view, choose run 200 from the popup menu of the Run 
For Time button to advance the simulation by 200 nanoseconds. 

Notice that the simulation probes on the test bench block diagram change color from 
yellow to red as their signal values are initialized. 

3. Click the Run Forever button to run the simulator until the breakpoint is encountered. 
Notice that the waveform updates through the Fibonacci sequence 0, 1, 2, 3, 5, 8, 13, 21, 
34, 55, 89 and 144 as the simulation advances and that a blue arrow appears after the line 
number in the Seq_Generator.v source window.
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4. Click the Run Forever button again and notice that the sequence from 0 to 144 is 
repeated. 

5. Make the source window active and remove the breakpoint by right clicking on the BP 
column of line 193 and choosing Remove Breakpoint 193 from the popup menu.

6. In the fibgen_tb block diagram click the  button adjacent to the Run For Time button 
on the toolbar and select Choose from the popup menu. A dialog box is displayed which 
allows you to enter a simulator run time interval. For example, enter 3000 into the entry 
box and click OK to run the simulator.

Notice that the Fibonacci sequence repeats every 2,650 nano-seconds.

You can display the full waveform in the ModelSim Wave window by choosing Zoom 
Full from the Zoom cascade of the Wave cascade of the View menu. 

You can restart the simulation by using the Restart Simulator button.

7. Simulation is now complete. Choose Quit from the ModelSim File menu to exit from 
the simulator. Click Yes to the exit message. Close the fibgen_tb block diagram. 

Synthesize the Design
If your FPGA Advantage configuration includes both LeonardoSpectrum and Precision 
Synthesis, you can perform the synthesis procedures using either of these tools.
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Procedures for Running the LeonardoSpectrum Flow are given on page 27.

Procedures for Running the Precision Synthesis Flow are given on page 30.

Running the LeonardoSpectrum Flow
1. Select the fibgen component in the design manager and click on the  button. To 

add the button to the toolbar choose Toolbar from the Add to cascade of Leonardo 
Spectrum flow popup menu in the Tasks pane.

The LeonardoSpectrum Synthesis Settings dialog is displayed. 

2. Select the technology of your choice in the Setup tab. For example, choose FPGA> 
Xilinx> XC4000E. 

When you select a technology, default values are automatically entered in the Device, 
Speed Grade and Wire Table fields. 
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3. Enter the value 20 in the Design Frequency field and synthesize your design using the 
default options in the remaining fields by clicking the OK button. 

When you confirm the dialog box, your design is synthesized and optimized for the 
selected technology. 

LeonardoSpectrum optimizes the design. Progress and completion messages are 
displayed in the information window showing that the synthesis run has finished.
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View the LeonardoSpectrum RTL Schematic
1. If you are using the Level 3 license, you can display an RTL Schematic for your design 

by clicking the View RTL Schematic button. 

You can move around the schematic using the scroll bars and the diagram can be 
enlarged inside the browser by choosing Zoom In from the Zoom cascade of the 
Schematic Viewer pulldown menu.

You can cross-probe from the schematic to the corresponding object in a HDS source 
view by selecting an instance on the schematic and clicking the right mouse button and 
choosing Trace to HDL Designer from the popup menu.

Note
The Schematic Viewer is not available with a LeonardoSpectrum level 2 license unless 
you have an additional license feature for LeonardoInsight.

2. You have now completed this tutorial. Close any cross-referenced windows. Close the 
LeonardoSpectrum window by choosing Exit from the File menu and answering No 
when you are prompted whether to save your project settings. Close the HDS window 
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by choosing Exit from the File menu in the design manager window and answering Yes 
in the confirmation dialog box.

Running the Precision Synthesis Flow
1. Select the fibgen component in the HDS Design Manager and click on the Precision 

Synthesis Flow button. 

The Precision Synthesis Settings dialog is displayed.

2. Select the technology of your choice in the Setup tab. For example, choose Xilinx> 
CoolRunner XPLA3CPLDS. 
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When you select a technology, default values are automatically entered in the Device 
and Speed Grade fields. 

3. Enter the value 20 in the Design Frequency/Period field and synthesize your design 
using the default options in the remaining fields by clicking the OK button. 

The Precision Synthesis design center window is displayed showing all of the project 
files and design hierarchy for the synthesized design. The contents of the Log File in the 
Output Files folder shows the progress and completion of the synthesis run and indicates 
that synthesis has been completed successfully.

You can double-click the Log File or any other file in the design center to check and 
monitor the progress of the synthesis tool.

View the Precision Synthesis RTL Schematic
1. Double-click the RTL Schematic icon in the list of output files in the Project Files pane 

to open the schematic diagram in a new Design Browser tab.
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You can move around the schematic using the scroll bars or the diagram can be enlarged 
inside the browser by choosing the Zoom In shortcut. You can also use the Zoom Out 
or Zoom To Fit shortcuts to view and adjust the diagram inside the browser.

You can cross-probe from the schematic to the corresponding object in a HDS source 
view by selecting an instance on the schematic and clicking the right mouse button and 
choosing Trace to HDL Designer from the popup menu.

2. You have now completed this tutorial. Close any cross-referenced windows. Close the 
Precision Synthesis window by choosing Exit from the File menu and answering No 
when you are prompted whether to save your project settings. Close the HDS window 
by choosing Exit from the File menu in the design manager window and answering Yes 
in the confirmation dialog box.

About Gate Level Simulation
The FPGA Advantage Tutorial has shown how to create a simple design flow using a sample 
text design. The design flow showed the first stage of simulation at RTL level using ModelSim 
as part of the FPGA Advantage design environment.
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A second stage of simulation is possible at gate-level after synthesis where the output of an 
FPGA vendors place and route tool is used to create a gate-level netlist. 

The netlist may also include timing information which is defined in a Standard Delay File (.sdf). 

This flow is shown in the diagram below where a post place and route gate-level netlist is 
loaded into the simulation environment along with the.sdf file.

Further Information
Each of the tools integrated within FPGA Advantage support a large range of features which 
cannot be illustrated in this simple tutorial. For more information, see links which are available 
from the Help menu in each tool.

General information about the documentation including a list of other HDL Designer Series 
tutorials can be found in the Start Here Guide for FPGA Advantage.

Information about supported third party vendors tools can be found at:

http://www.altera.com
http://www.xilinx.com

http://www.altera.com
http://www.xilinx.com
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End-User License Agreement
The latest version of the End-User License Agreement is available on-line at:

www.mentor.com/terms_conditions/enduser.cfm

END-USER LICENSE AGREEMENT (“Agreement”)

This is a legal agreement concerning the use of Software between you, the end user, as an authorized
representative of the company acquiring the license, and Mentor Graphics Corporation and Mentor Graphics
(Ireland) Limited acting directly or through their subsidiaries (collectively “Mentor Graphics”). Except for license
agreements related to the subject matter of this license agreement which are physically signed by you and an
authorized representative of Mentor Graphics, this Agreement and the applicable quotation contain the parties'
entire understanding relating to the subject matter and supersede all prior or contemporaneous agreements. If you
do not agree to these terms and conditions, promptly return or, if received electronically, certify destruction of
Software and all accompanying items within five days after receipt of Software and receive a full refund of any
license fee paid. 

1. GRANT OF LICENSE. The software programs, including any updates, modifications, revisions, copies, documentation
and design data (“Software”), are copyrighted, trade secret and confidential information of Mentor Graphics or its
licensors who maintain exclusive title to all Software and retain all rights not expressly granted by this Agreement.
Mentor Graphics grants to you, subject to payment of appropriate license fees, a nontransferable, nonexclusive license to
use Software solely: (a) in machine-readable, object-code form; (b) for your internal business purposes; (c) for the license
term; and (d) on the computer hardware and at the site authorized by Mentor Graphics. A site is restricted to a one-half
mile (800 meter) radius. Mentor Graphics’ standard policies and programs, which vary depending on Software, license
fees paid or services purchased, apply to the following: (a) relocation of Software; (b) use of Software, which may be
limited, for example, to execution of a single session by a single user on the authorized hardware or for a restricted period
of time (such limitations may be technically implemented through the use of authorization codes or similar devices); and
(c) support services provided, including eligibility to receive telephone support, updates, modifications, and revisions. 

2. EMBEDDED SOFTWARE. If you purchased a license to use embedded software development (“ESD”) Software, if
applicable, Mentor Graphics grants to you a nontransferable, nonexclusive license to reproduce and distribute executable
files created using ESD compilers, including the ESD run-time libraries distributed with ESD C and C++ compiler
Software that are linked into a composite program as an integral part of your compiled computer program, provided that
you distribute these files only in conjunction with your compiled computer program. Mentor Graphics does NOT grant
you any right to duplicate, incorporate or embed copies of Mentor Graphics' real-time operating systems or other
embedded software products into your products or applications without first signing or otherwise agreeing to a separate
agreement with Mentor Graphics for such purpose.

3. BETA CODE. Software may contain code for experimental testing and evaluation (“Beta Code”), which may not be used
without Mentor Graphics’ explicit authorization. Upon Mentor Graphics’ authorization, Mentor Graphics grants to you a
temporary, nontransferable, nonexclusive license for experimental use to test and evaluate the Beta Code without charge
for a limited period of time specified by Mentor Graphics. This grant and your use of the Beta Code shall not be construed
as marketing or offering to sell a license to the Beta Code, which Mentor Graphics may choose not to release
commercially in any form. If Mentor Graphics authorizes you to use the Beta Code, you agree to evaluate and test the
Beta Code under normal conditions as directed by Mentor Graphics. You will contact Mentor Graphics periodically
during your use of the Beta Code to discuss any malfunctions or suggested improvements. Upon completion of your
evaluation and testing, you will send to Mentor Graphics a written evaluation of the Beta Code, including its strengths,
weaknesses and recommended improvements. You agree that any written evaluations and all inventions, product
improvements, modifications or developments that Mentor Graphics conceived or made during or subsequent to this
Agreement, including those based partly or wholly on your feedback, will be the exclusive property of Mentor Graphics.
Mentor Graphics will have exclusive rights, title and interest in all such property. The provisions of this section 3 shall
survive the termination or expiration of this Agreement.

 IMPORTANT INFORMATION 

USE OF THIS SOFTWARE IS SUBJECT TO LICENSE RESTRICTIONS. CAREFULLY READ THIS 
LICENSE AGREEMENT BEFORE USING THE SOFTWARE. USE OF SOFTWARE INDICATES YOUR 
COMPLETE AND UNCONDITIONAL ACCEPTANCE OF THE TERMS AND CONDITIONS SET FORTH 

IN THIS AGREEMENT. ANY ADDITIONAL OR DIFFERENT PURCHASE ORDER TERMS AND 
CONDITIONS SHALL NOT APPLY.

http://www.mentor.com/terms_conditions/enduser.cfm


4. RESTRICTIONS ON USE. You may copy Software only as reasonably necessary to support the authorized use. Each
copy must include all notices and legends embedded in Software and affixed to its medium and container as received from
Mentor Graphics. All copies shall remain the property of Mentor Graphics or its licensors. You shall maintain a record of
the number and primary location of all copies of Software, including copies merged with other software, and shall make
those records available to Mentor Graphics upon request. You shall not make Software available in any form to any
person other than employees and on-site contractors, excluding Mentor Graphics' competitors, whose job performance
requires access and who are under obligations of confidentiality. You shall take appropriate action to protect the
confidentiality of Software and ensure that any person permitted access to Software does not disclose it or use it except as
permitted by this Agreement. Except as otherwise permitted for purposes of interoperability as specified by applicable
and mandatory local law, you shall not reverse-assemble, reverse-compile, reverse-engineer or in any way derive from
Software any source code. You may not sublicense, assign or otherwise transfer Software, this Agreement or the rights
under it, whether by operation of law or otherwise (“attempted transfer”), without Mentor Graphics’ prior written consent
and payment of Mentor Graphics’ then-current applicable transfer charges. Any attempted transfer without Mentor
Graphics' prior written consent shall be a material breach of this Agreement and may, at Mentor Graphics' option, result in
the immediate termination of the Agreement and licenses granted under this Agreement. The terms of this Agreement,
including without limitation, the licensing and assignment provisions shall be binding upon your successors in interest
and assigns. The provisions of this section 4 shall survive the termination or expiration of this Agreement.

5. LIMITED WARRANTY. 

5.1. Mentor Graphics warrants that during the warranty period Software, when properly installed, will substantially
conform to the functional specifications set forth in the applicable user manual. Mentor Graphics does not warrant
that Software will meet your requirements or that operation of Software will be uninterrupted or error free. The
warranty period is 90 days starting on the 15th day after delivery or upon installation, whichever first occurs. You
must notify Mentor Graphics in writing of any nonconformity within the warranty period. This warranty shall not be
valid if Software has been subject to misuse, unauthorized modification or improper installation. MENTOR
GRAPHICS' ENTIRE LIABILITY AND YOUR EXCLUSIVE REMEDY SHALL BE, AT MENTOR GRAPHICS'
OPTION, EITHER (A) REFUND OF THE PRICE PAID UPON RETURN OF SOFTWARE TO MENTOR
GRAPHICS OR (B) MODIFICATION OR REPLACEMENT OF SOFTWARE THAT DOES NOT MEET THIS
LIMITED WARRANTY, PROVIDED YOU HAVE OTHERWISE COMPLIED WITH THIS AGREEMENT.
MENTOR GRAPHICS MAKES NO WARRANTIES WITH RESPECT TO: (A) SERVICES; (B) SOFTWARE
WHICH IS  LICENSED TO YOU FOR A LIMITED TERM OR LICENSED AT NO COST;  OR
(C) EXPERIMENTAL BETA CODE; ALL OF WHICH ARE PROVIDED “AS IS.”

5.2. THE WARRANTIES SET FORTH IN THIS SECTION 5 ARE EXCLUSIVE. NEITHER MENTOR GRAPHICS
NOR ITS LICENSORS MAKE ANY OTHER WARRANTIES, EXPRESS, IMPLIED OR STATUTORY, WITH
RESPECT TO SOFTWARE OR OTHER MATERIAL PROVIDED UNDER THIS AGREEMENT. MENTOR
GRAPHICS AND ITS LICENSORS SPECIFICALLY DISCLAIM ALL IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE AND NON-INFRINGEMENT OF
INTELLECTUAL PROPERTY.

6. LIMITATION OF LIABILITY. EXCEPT WHERE THIS EXCLUSION OR RESTRICTION OF LIABILITY
WOULD BE VOID OR INEFFECTIVE UNDER APPLICABLE LAW, IN NO EVENT SHALL MENTOR GRAPHICS
OR ITS LICENSORS BE LIABLE FOR INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES
(INCLUDING LOST PROFITS OR SAVINGS) WHETHER BASED ON CONTRACT, TORT OR ANY OTHER
LEGAL THEORY, EVEN IF MENTOR GRAPHICS OR ITS LICENSORS HAVE BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES. IN NO EVENT SHALL MENTOR GRAPHICS' OR ITS LICENSORS'
LIABILITY UNDER THIS AGREEMENT EXCEED THE AMOUNT PAID BY YOU FOR THE SOFTWARE OR
SERVICE GIVING RISE TO THE CLAIM. IN THE CASE WHERE NO AMOUNT WAS PAID, MENTOR
GRAPHICS AND ITS LICENSORS SHALL HAVE NO LIABILITY FOR ANY DAMAGES WHATSOEVER. THE
PROVISIONS OF THIS SECTION 6 SHALL SURVIVE THE EXPIRATION OR TERMINATION OF THIS
AGREEMENT.

7. LIFE ENDANGERING ACTIVITIES. NEITHER MENTOR GRAPHICS NOR ITS LICENSORS SHALL BE
LIABLE FOR ANY DAMAGES RESULTING FROM OR IN CONNECTION WITH THE USE OF SOFTWARE IN
ANY APPLICATION WHERE THE FAILURE OR INACCURACY OF THE SOFTWARE MIGHT RESULT IN
DEATH OR PERSONAL INJURY.   THE PROVISIONS OF THIS SECTION 7 SHALL SURVIVE THE
EXPIRATION OR TERMINATION OF THIS AGREEMENT.

8. INDEMNIFICATION. YOU AGREE TO INDEMNIFY AND HOLD HARMLESS MENTOR GRAPHICS AND ITS
LICENSORS FROM ANY CLAIMS, LOSS, COST, DAMAGE, EXPENSE, OR LIABILITY, INCLUDING
ATTORNEYS' FEES, ARISING OUT OF OR IN CONNECTION WITH YOUR USE OF SOFTWARE AS



DESCRIBED IN SECTION 7. THE PROVISIONS OF THIS SECTION 8 SHALL SURVIVE THE EXPIRATION OR
TERMINATION OF THIS AGREEMENT.

9. INFRINGEMENT. 

9.1. Mentor Graphics will defend or settle, at its option and expense, any action brought against you alleging that
Software infringes a patent or copyright or misappropriates a trade secret in the United States, Canada, Japan, or
member state of the European Patent Office. Mentor Graphics will pay any costs and damages finally awarded
against you that are attributable to the infringement action. You understand and agree that as conditions to Mentor
Graphics' obligations under this section you must: (a) notify Mentor Graphics promptly in writing of the action;
(b) provide Mentor Graphics all reasonable information and assistance to defend or settle the action; and (c) grant
Mentor Graphics sole authority and control of the defense or settlement of the action.

9.2. If an infringement claim is made, Mentor Graphics may, at its option and expense: (a) replace or modify Software so
that it becomes noninfringing; (b) procure for you the right to continue using Software; or (c) require the return of
Software and refund to you any license fee paid, less a reasonable allowance for use.

9.3. Mentor Graphics has no liability to you if infringement is based upon: (a) the combination of Software with any
product not furnished by Mentor Graphics; (b) the modification of Software other than by Mentor Graphics; (c) the
use of other than a current unaltered release of Software; (d) the use of Software as part of an infringing process; (e) a
product that you make, use or sell; (f) any Beta Code contained in Software; (g) any Software provided by Mentor
Graphics’ licensors who do not provide such indemnification to Mentor Graphics’ customers; or (h) infringement by
you that is deemed willful. In the case of (h) you shall reimburse Mentor Graphics for its attorney fees and other costs
related to the action upon a final judgment.

9.4. THIS SECTION IS SUBJECT TO SECTION 6 ABOVE AND STATES THE ENTIRE LIABILITY OF MENTOR
GRAPHICS AND ITS LICENSORS AND YOUR SOLE AND EXCLUSIVE REMEDY WITH RESPECT TO
ANY ALLEGED PATENT OR COPYRIGHT INFRINGEMENT OR TRADE SECRET MISAPPROPRIATION
BY ANY SOFTWARE LICENSED UNDER THIS AGREEMENT.

10. TERM. This Agreement remains effective until expiration or termination. This Agreement will immediately terminate
upon notice if you exceed the scope of license granted or otherwise fail to comply with the provisions of Sections 1, 2, or
4. For any other material breach under this Agreement, Mentor Graphics may terminate this Agreement upon 30 days
written notice if you are in material breach and fail to cure such breach within the 30 day notice period. If Software was
provided for limited term use, this Agreement will automatically expire at the end of the authorized term. Upon any
termination or expiration, you agree to cease all use of Software and return it to Mentor Graphics or certify deletion and
destruction of Software, including all copies, to Mentor Graphics’ reasonable satisfaction.   

11. EXPORT. Software is subject to regulation by local laws and United States government agencies, which prohibit export
or diversion of certain products, information about the products, and direct products of the products to certain countries
and certain persons. You agree that you will not export any Software or direct product of Software in any manner without
first obtaining all necessary approval from appropriate local and United States government agencies.

12. RESTRICTED RIGHTS NOTICE. Software was developed entirely at private expense and is commercial computer
software provided with RESTRICTED RIGHTS. Use, duplication or disclosure by the U.S. Government or a U.S.
Government subcontractor is subject to the restrictions set forth in the license agreement under which Software was
obtained pursuant to DFARS 227.7202-3(a) or as set forth in subparagraphs (c)(1) and (2) of the Commercial Computer
Software - Restricted Rights clause at FAR 52.227-19, as applicable. Contractor/manufacturer is Mentor Graphics
Corporation, 8005 SW Boeckman Road, Wilsonville, Oregon 97070-7777 USA.

13. THIRD PARTY BENEFICIARY. For any Software under this Agreement licensed by Mentor Graphics from Microsoft
or other licensors, Microsoft or the applicable licensor is a third party beneficiary of this Agreement with the right to
enforce the obligations set forth herein.

14. AUDIT RIGHTS. You will monitor access to, location and use of Software. With reasonable prior notice and during
your normal business hours, Mentor Graphics shall have the right to review your software monitoring system and
reasonably relevant records to confirm your compliance with the terms of this Agreement, an addendum to this
Agreement or U.S. or other local export laws. Such review may include FLEXlm or FLEXnet report log files that you
shall capture and provide at Mentor Graphics’ request. Mentor Graphics shall treat as confidential information all of your
information gained as a result of any request or review and shall only use or disclose such information as required by law
or to enforce its rights under this Agreement or addendum to this Agreement. The provisions of this section 14 shall
survive the expiration or termination of this Agreement.



15. CONTROLLING LAW, JURISDICTION AND DISPUTE RESOLUTION. THIS AGREEMENT SHALL BE
GOVERNED BY AND CONSTRUED UNDER THE LAWS OF THE STATE OF OREGON, USA, IF YOU ARE
LOCATED IN NORTH OR SOUTH AMERICA, AND THE LAWS OF IRELAND IF YOU ARE LOCATED
OUTSIDE OF NORTH OR SOUTH AMERICA. All disputes arising out of or in relation to this Agreement shall be
submitted to the exclusive jurisdiction of Portland, Oregon when the laws of Oregon apply, or Dublin, Ireland when the
laws of Ireland apply. Notwithstanding the foregoing, all disputes in Asia (except for Japan) arising out of or in relation to
this Agreement shall be resolved by arbitration in Singapore before a single arbitrator to be appointed by the Chairman of
the Singapore International Arbitration Centre (“SIAC”) to be conducted in the English language, in accordance with the
Arbitration Rules of the SIAC in effect at the time of the dispute, which rules are deemed to be incorporated by reference
in this section 15. This section shall not restrict Mentor Graphics’ right to bring an action against you in the jurisdiction
where your place of business is located. The United Nations Convention on Contracts for the International Sale of Goods
does not apply to this Agreement.

16. SEVERABILITY. If any provision of this Agreement is held by a court of competent jurisdiction to be void, invalid,
unenforceable or illegal, such provision shall be severed from this Agreement and the remaining provisions will remain in
full force and effect. 

17. PAYMENT TERMS AND MISCELLANEOUS. You will pay amounts invoiced, in the currency specified on the
applicable invoice, within 30 days from the date of such invoice. Any past due invoices will be subject to the imposition
of interest charges in the amount of one and one-half percent per month or the applicable legal rate currently in effect,
whichever is lower. Some Software may contain code distributed under a third party license agreement that may provide
additional rights to you. Please see the applicable Software documentation for details. This Agreement may only be
modified in writing by authorized representatives of the parties. Waiver of terms or excuse of breach must be in writing
and shall not constitute subsequent consent, waiver or excuse. 
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